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1. Introduction 
The Wireless Information System for Emergency Responders (WISER) is a system concept for providing 
First Responders at the scene of hazardous material incidents – chemical, biological, or radioactive – with 
integrated information, decision support, and communications.  WISER provides critical chemical 
information quickly and conveniently on mobile devices, such as PDAs, Windows Desktop computers, 
tablet computers, field laptops, mobile phones, and mobile data terminals.  It aids in the identification of 
unknown chemicals and, once the chemical is identified, provides guidance on immediate actions 
necessary to save lives and protect the environment.  Substance information and identification properties 
come from the Hazardous Substances Data Bank (HSDB), developed and maintained by the National 
Library of Medicine.   

WISER currently exists as a standalone PDA application for Pocket PC or Palm OS devices and as a 
Windows Desktop application; this document describes the Windows Desktop version. WISER contains 
HSDB information and decision support logic for 400+ substances (future versions will provide access to 
more substances).  The substances were chosen based on First Responder inputs, degree of chemical 
hazard, and historical frequency of incidents.  The WISER application assists First Responders in rapidly 
determining the substance involved and gives the First Responder critical information regarding the 
substance, allowing them to take the necessary immediate actions to minimize the effects of the hazmat 
incident. 

1.1. Features 
 Access to data from the Hazardous Substance Data Bank, covering basic, physical, 

hazardous material, medical, and environmental areas 

 Multiple substances, chosen based on First Responder inputs, degree of chemical hazard, 
and historical frequency of incidents 

 Substance identification support, based on physical properties, patient symptoms, NFPA 704 
hazard values, and substance categories 

 General tools and reference materials for on-scene support, e.g., the complete Emergency 
Response Guidebook, and the WMD Response Guidebook 

 Biological substance list and substance data 

 Radiologicals 

• Radioisotope substance list and substance data 

• Tools and reference documentation for on-scene support of radiological events 

1.2. System Requirements 
For system requirements, please see the README that is included in the WISER installation, or in the 
download section of the WISER website. 

http://wiser.nlm.nih.gov/
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ER 1.3. Installing WIS
For instructions on installing and uninstalling WISER, please see the README that is included in the 
WISER installation, or in the download section of the WISER website. 

1.4. Disclaimer 
The U.S. Government does not warrant or assume any legal liability or responsibility for the accuracy, 

ten ratus, product, or process disclosed. 

al advice to the public, but rather to provide users 

Th nformation for this software is 
available in the file DisclaimerAndLicenses.txt that is included with the WISER distribution.  This third-
party software consists of: 

 SharpZipLib - produced by Mike Krueger.  See 
http://www.icsharpcode.net/OpenSource/SharpZipLib/Default.aspx

comple ess, or usefulness of any information, appa

It is not the intention of NLM to provide specific medic
with information to better understand their health. 

NLM does not endorse or recommend any commercial products, process, or services.  

1.5. Software Used by WISER 
e WISER application makes use of third-party software. License i

. SharpZipLib is used to 
compress and uncompress data in the WISER database. 
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2. Using WISER 
The WISER application is run from the WISER Desktop Shortcut or the Start Programs menu. 

1. Double-click on the WISER Desktop Shortcut. 
or 

1. Select Start Programs WISER Windows 
2. Double-click on the WISER application icon. 

 
During startup of the application the following “splash screen” will be displayed for several seconds while 
the application loads. 

 

 
The remainder of this section details the functionality on each of the windows that comprise the WISER 
application.  

2.1. Overview 
WISER consist of the following primary windows: 

 Known Substance Window – contains the substance list 

 Data Window – displays substance data for a selected substance 

 Help Identify Window – for identification of unknown chemicals 

Each of these windows has in common a menu and toolbar at the top of the window for selecting the user 
profile and other various options which will be discussed later in this document. 

Home Help Identify Print WISER Help Profile selector 
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WISER also provides a set of tools and reference materials, not related to a 
specific WISER substance. These are accessed via the “Chemical Tools”, 
“Biological Tools”, and “Radiological Tools” tabs on the right edge of the 
window. To display the available options, mouse-over or click on the desired 
tab. 

 

 

 

 

 

 

 

 

 

 

 

 

2.1.1. Setting the User Profile 

The User Profile determines how certain information is presented by WISER, tailoring the application to 
suit the needs of the type of user. Specifically, it controls what ‘hot links’ are presented on the Data 
Window’s data menu, ensuring that the most relevant information is the most readily available. 

To set the User Profile, click the toolbar’s profile button or dropdown 
arrow. When this is done, a context menu opens presenting the available 
profiles, as shown at right. 

The current profile selection is indicated with a checkmark in the menu, 
and by a corresponding icon on the toolbar button. The icons for each of 
the profile options are as follows: 

   1st Responder, e.g., first engine on the scene   1st Responder, e.g., first engine on the scene 

   Hazmat Specialist   

   Emergency Medical Specialist (EMS) 

Each time WISER is started the User Profile setting from its previous use is restored. 

 



 

WISER User's Guide Using WISER 

 
 
 

2008-04-24 National Library of Medicine Page 7 

2.1.2. File Menu  

The File menu provides the ability to exit the WISER application, print, and display 
the user Preferences dialog. 

The Preferences dialog, shown below, provides user preference settings that will 
be retained across invocations of the WISER application. 

The available preferences are as follows: 

 Confirmation of substance removals from search results: see the Search Preferences section 
for details. 

 On-line lookup option on the Data Window: see the On-line 
Substance Lookup section for details. 

 Automatic Updates: selecting this option will cause WISER to 
automatically check the WISER web site for a new version 
each time it is started. If Internet connectivity or a new version 
is not available, this will be transparent to the user. Otherwise, 
a dialog is presented giving you the option of being taken to 
the WISER web site to download the new version. For 
additional details, please see the README file that is 
installed with WISER. 

The Edit menu provides the ability to handle standard text editing capabilities such as Undo, Cut, Copy, 
Paste, Delete, and Select All.  These features are only available on certain areas of the application and 
will be disabled in areas that are not capable of supporting these functions. 

2.1.3. Edit Menu 

The Edit menu provides the ability to handle standard text editing capabilities such as Undo, Cut, Copy, 
Paste, Delete, and Select All.  These features are only available on certain areas of the application and 
will be disabled in areas that are not capable of supporting these functions. 

2.1.4. Window Menu 

The “Window” menu item is used to control the various windows in the WISER application.  The WISER 
application is a MDI (Multi-Document Interface) application, which means that all of the primary windows 
are actually child windows inside a main parent window as shown in the second image. 
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The “Arrange” menu has several options for organizing all of the child windows within the parent window.  
This includes the ability to minimize all child windows, restore the child windows back to their previous 
positions, arrange the windows in a horizontal or vertical layout and cascade each window.  The “Close 
All” menu allows for the closing of all child windows within the parent.  Below the “Close All” menu option 
is a listing of all available child windows with the active child window containing a check mark next to it.  
Selecting any of these menu options will activate or give focus to that child window within the parent. 

2.1.5. Help Menu  

As shown at right, help content is accessible via the “Help” menu option. 

There are two types of help content available at any given time, Topics and 
Details.  The Topics option launches the help starting at the beginning of the 
help content (table of contents).  The Help Details option is context sensitive, 
launching help at the content that describes the active window. 

The QuickStart Guide and User’s Guide options open the external 
documentation that is packaged with the WISER installation. Adobe Reader 
or equivalent PDF-viewing software is required to view these documents. 

The next two options, Register for Notifications and Check for Updates, require Internet connectivity. 
The Register for Notifications option opens a web browser and takes you to the WISER web site, 
displaying the page where you can join the WISER e-mail list. This list is used to periodically send out 

Child Windows Parent Window 

http://www.adobe.com/products/acrobat/readstep2.html
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notifications related to WISER, such as the availability of new versions. If you did not register when you 
downloaded WISER, or did not receive WISER via a download from the web site, then it is strongly 
encouraged that you do so to ensure you are kept up to date with the latest WISER news. E-mails from 
this list will be very infrequent, and your e-mail address will never be used for any other purpose. 

The Check for Updates option checks the WISER web site to see if there 
is a new version of WISER. If not, a dialog displays indicating “No updates 
are available.” If a newer version is available, a dialog displays similar to 
that shown on the right. Pressing the Download button opens a web 
browser and takes you to the WISER web site, displaying the page from 
which you can download the new version. For additional details, see the 
README file that is installed with WISER. 

Finally, the About WISER dialog, shown below, is accessible from this 
menu option.  This dialog includes database and application version information along with the WISER 
disclaimer text. 

 

2.1.6. Navigation 

Access to the Main Window, is available via the Home button  on the toolbar. Selecting this returns to 
the Main Window at any point within the application. 
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Navigation between the three primary windows is as follows: 

Data 
Window 

Search 
Window 

Substance Selection 

Home button 

Help Identify 
Button 

Results list 
substance 
selection 

Help Identify 
button 

Home button 

Main 
Window 
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2.1.7. Printing 

A print option is available on the Data Window, the Help Identify Window and other printable windows via 
the toolbar or the File menu. When printing from the Data Window, a dialog is presented that allows 
printing of either the currently displayed data or a custom selection of any or all of the data for the 
substance being viewed. When printing from a Help Identify Window a summary of the current search, 
consisting of each of the selected properties, symptoms, NFPA 704 hazard values, substance categories, 
and the results list is printed. 

2.1.8. Closing WISER 

To close the WISER application, click the  button of the parent window or select the File Exit menu 
option from the main menu. 

2.1.9. Checking for Updates 

To close the WISER application, click the  button of the parent window or select the File Exit menu 
option from the main menu. 

2.2. Main Window – Known Substance List  
The main window is presented upon startup of WISER or any time the home button is selected on the 
toolbar. The primary purpose of this window is to locate a substance by its name or one of its 
identification numbers, and then navigate to the substance data window to view the data specific to that 
substance. If trying to identify an unknown chemical, then this window provides a Help Identify Unknown 
button, as shown below, that advances to the Help Identify Window where functionality is available for 
identifying the chemical. 
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Clear the search text 

Click either 
button to 
identify an 
unknown 
substance 

Filter by substance “type” Sort order / search by Search text 

Size of substance list Double-click to view substance data Scroll the substance list 

If you know what the substance is, then you can locate it in the list using the following features: 

 Browsing  through the list of substances using the scrollbar 

 Ordering the list by substance name or one of the substance identification numbers, where 
the possibilities are UN/NA number, CAS registry number, and STCC number 

 Performing a search by entering the name or one of the identifiers into the search text box 

 Filtering based on the “type” of substance (all substances, all chemicals, all biologicals, all 
radiologicals) 

 Additional filtering based on selected substance categories (type selection = “Substances, 
Filter by Category”) 

Upon locating the desired substance in the substance list, double-clicking it displays the Data Window for 
that substance. 

2.2.1. Searching by Name or Identifier 

To search for a substance name or identifier, use the Search by pull-down to order the list and indicate 
the text that will be entered in the text field. The options are as follows: 

 Name: list is ordered alphabetically by name 

 UN/NA: list is ordered by UN/NA number 

 CAS RN: list is ordered by CAS registry number 

 STCC: list is ordered by STCC number 
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The text field to the right of this selection will then prompt for the search text. Click in the text field and 
begin typing. As characters are entered, the content of the list changes to display only those substances 
that match the search text. The status display along the bottom of the window indicates the number of 
substances in the updated list, and the fact that the list is reflecting the results of a search. 
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Enter search text here Click here Select one of these 

Indicates list contains results of a search  Number of substances in search results 

 
A ‘*’ character can be entered in the search text as a wildcard character. A wildcard character at the end 
of the search text is always implied. For example, 

 Entering “chlorine” as the search text is the same as entering “chlorine*”, and results in a list 
of substances whose name starts with “chlorine” 
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 Entering “*fluoride” as the search text results in a list of substances whose name contains 
“fluoride” 

 

2.2.1.1. Search by Name 

When Name is selected from the Search By menu, the substance list is alphabetically sorted, and is 
augmented with synonyms, i.e. other names by which the substances in WISER are known.  

Note that numbers and punctuation that prefix a name are ignored for sorting and search purposes, and 
leading numbers and punctuation in the search text field are ignored as well. 

2.2.1.2. Search by Identifier 

As shown in the following figure, when UN/NA, CAS RN, or STCC is selected from the Search By menu, 
the substance list contains only the core HSDB substance names (no synonyms), is order by the selected 
identification number, and each substance name is prefixed with the identification number. A particular 
substance will occur in the list for each unique identifier that it has; for example, a substance may have 
multiple UN/NA numbers, and thus will occur in the list once for each of those numbers in the UN/NA-
sorted list. 

In the case of STCC numbers, whose format contains embedded spaces, those spaces need not be 
entered in the search text. 
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2.2.2. Filtering by Substance Type 

By default, the substance list includes all substance in WISER. The list can be filtered to include only a 
particular type of substance, e.g., chemicals, biologicals, or radiologicals. 

Select one of these Click here 
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This is an example of filtering by substance categories, and the status bar indicating this: 

Indicates a filtered list is displayed 
 

When the list is filtered in this fashion, any subsequent searches will occur only against the filtered list. 

2.2.3. Filtering by Substance Categories 

In the previous section, the list was filtered by selecting a predetermined filter, e.g., chemical vs. 
biological vs. radiological. A custom filter can instead be applied that allows filtering by additional 
substance categories. To display this type of substance list, select the “Substances, Filter By Category” 
option from the drop-down list, as shown, below, and a “Filter By Category” dialog window will appear. 

Select this option Category selection dialog automatically appears 

Use the Filter By Category dialog to explore the available substance categories as a tree, and to indicate 
which ones to include in the filter by selecting the checkboxes next to the category names. 
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Press OK to accept filter changes 

Checkboxes indicate 
the categories 
included in the filter 

Click +/- symbols to 
open/close branches 
of the tree 

 
When complete, select OK, and the substance list will update to include only those substances that are a 
member of any one of the categories that were selected. 

Press to return to “Filter By Category” dialog 

Indicates filtered list, and the categories in the filter 
Mouse-over to pop-up a display of all selected categories 
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As shown above, when displaying a filtered list, a “Filter” button is available to return to the “Filter By 
Category” dialog, where the selected categories can be reviewed and changed. In addition, the status bar 
indicates the list is filtered-by-category, displays the selected categories, and can be clicked on to return 
to the “Filter By Category” dialog. This status area may not be large enough to display the selections, but 
if the mouse pointer is moved overtop of it, a pop-up will appear that lists the selections. 

When the list is filtered in this fashion, any subsequent searches will occur only against the filtered list. If 
the substance list type is changed, e.g., back to “All Known Substances”, and then changed back to the 
filtered list, the last entered filter will be retained. 

2.3. Data Window 
The Data Window is presented upon double-clicking a substance name from the Main Window’s Known 
Substance List or from the Help Identify results list.  It is used to select and view all data that is available 
for the substance. To return to the Main Window, select the Home button on the toolbar, or close the Data 
Window by pressing its close button (the ‘X’ in its top right corner). 

Double-click here 

 
As shown in the above figure, the top of the Data Window indicates the name of the substance and its 
CAS registry number. If an alias of the substance was selected from the Main Window, the alias is 
indicated next to the substance name. If the Main window was sorted by UN/NA or STCC numbers, then 
those ID numbers will be included next to the CAS.  In the above example, “Formic Aldehyde,” an alias of 
the substance known in the HSDB as Formaldehyde, was chosen from the Main Window’s substance list. 

The Data Window initially displays Key Info, a summary of the most immediate, critical aspects of a 
substance. To see additional data, select the tab that displays the title of the data (“Key Info”), or select 
the Data menu in the top menu bar of the main window. These options present a menu of ‘hot links’ and 
submenus representing the different types of data available for the substance. 
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Click one of the data 
menu options Hot Links Submenus 

 

The hot links are generally duplicates of items found within the submenus, but provide a quicker way to 
get to the most relevant information for the user profile. What hot links are available depend on the user 
profile and the type of substance (chemical, biological, or radioisotope). 

The bottom portion of the Data menu contains submenu options, where each submenu represents a 
category of options. Selecting one of these pops up the submenu, listing the data elements in that 
category.  Again, the available options depend on the substance type. Selecting a submenu item replaces 
the previous data display contents with the selected data element and a heading bar above the data 
displays the menu and submenu selections. 
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Move mouse here Then click here 

 
The hot links that are available on the data menu for a chemical are as follows. Each is a duplicate of one 
of the submenu options, except for those “custom” options that are noted. 

 Common to all user profiles: 

• Key Info – this custom option present the most immediate dangers or considerations 
for an encounter with the substance 

• Identification – this custom option provides a summary of identification numbers, and 
a list of the “search value mappings” that will identify the substance when using the 
Help Identify Unknown feature, i.e., the properties, symptoms, NFPA 704 hazard 
values, and substance categories that apply to the substance 

 1st Responder profile 
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• PPE (Personal Protective Equipment & Clothing) – also available from the Hazmat 
submenu 

• Protective Distance – this custom option reflects the Public Safety section of the DOT 
Emergency Response Guidebook – also available from the Hazmat submenu 

• Fire Fighting Procedures – also available from the Hazmat submenu 

• Reactivities & Incompatibilities – also available from the Hazmat submenu 

• Treatment Overview – also available from the Medical submenu 

 Hazmat Specialist profile 

• Property Summary – this custom option provides a collection of select properties that 
are available separately under the Properties submenu – also available from the 
Properties submenu 

• PPE (Personal Protective Equipment & Clothing) – also available from the Hazmat 
submenu 

• IDLH (Immediately Dangerous to Life or Health) – also available from the Medical 
submenu 

• Flammable Limits – also available from the Hazmat submenu 

• NFPA Hazard Classification – also available from the Hazmat submenu 

 EMS profile 

• Treatment Overview – also available from the Medical submenu 

• Health Effects – also available from the Medical submenu 

• Toxicity Summary – also available from the Medical submenu 

• IDLH (Immediately Dangerous to Life or Health) – also available from the Medical 
submenu 

• NFPA Hazard Classification – also available from the Hazmat submenu 

The data elements available from the submenus of the data menu when viewing a chemical are shown 
below. When viewing data for radioisotopes, a subset of these are available. All data elements will not 
necessarily be available for all substances.

Basic Information 
• Shipping Name/Number 

(UN/NA/IMO identification numbers) 
• CAS Registry Number 
• STCC Number 
• Synonyms 
• Substance Categories 
• Molecular Formula 
• Shipment Methods & Regulations 
• EPA Hazardous Waste Number 
• Major Uses 
• Storage Conditions 

 

Properties 
• Property Summary 
• Color and Form 
• Taste  
• Odor 
• Autoignition Temperature 
• Boiling Point 
• Density/Specific Gravity 
• Decomposition 
• Flash Point 
• Ionization Potential 
• Molecular Formula 
• Melting Point 
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• Molecular Weight 
• Odor Threshold 
• pH 
• Polymerization 
• Solubilities 
• Stability/Shelf  Life 
• Vapor Density 
• Vapor Pressure 
• Viscosity 
• Other Properties 

 
Hazmat Information 

• DOT Emergency Guidelines 
• Protective Distance 
• WMD Response Guidelines 
• NFPA Hazard Classification 
• Fire Potential 
• Fire Fighting Procedures 
• Hazards Summary 
• PPE (Personal Protective 

Equipment & Clothing) 
• Flammable Limits 
• Toxic Combustion Products  
• Explosive Limits & Potential 
• Reactivities & Incompatibilities 
• Other Firefighting Hazards 
• Other Hazardous Reactions 
• Cleanup Methods 
• Disposal Methods 

 
Medical Information 

• Treatment Overview 
• Health Effects 
• AEGL (Acute Exposure Guideline 

Levels)  
• IDLH (Immediately Dangerous to 

Life or Health) 
• Threshold Limit Values 
• NIOSH Recommended Exposure 

Levels 
• OSHA Standards 
• Skin, Eye and Respiratory Irritations 
• Other Preventive Measures 
• Toxicity Summary 
• Range of Toxicity 
• Laboratory 
• Evidence for Carcinogenicity 
• Radiation Limits & Potential 
 

Environmental Information 
• Exposure Summary 
• Environmental Fate 
• CERCLA Reportable Quantities 
• Non-Human Toxicity Values  
• Ecotoxicity Values 
• Soil Adsorption/Mobility 
• Volatilization from Water/Soil

 

The data elements available when viewing a biological substance are shown below. 

Basic Information 
• Shipping Name/Number 

(UN/NA/IMO identification numbers) 
• Synonyms 
• Substance Categories 

 
Properties 

• Characteristics 
• Type of Harm 

 
Hazmat Information 

• DOT Emergency Guidelines 
• WMD Response Guidelines 
• Protective Distance 
• PPE (Personal Protective 

Equipment & Clothing) 
• Emergency Response 

 
Medical Information 

• Signs and Symptoms 
• Indicators 
• Clinical Features 
• Treatment Overview 
• Routes of Exposure 
• Transmission 
• Diagnosis 
• Prophylaxis 

 
Environmental Information 

• Occurrence 
• Reservoirs 
• Isolation and Decontamination 
• History 
• Delivery
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2.3.1. On-line Substance Lookup 

 

he 

At the bottom of the Data Window is a feature that 
permits an on-line lookup of the current substance. 
Whereas WISER is primarily intended to provide 
information relevant to the first responder community, 
this lookup feature provides a convenient means by 
which complete and comprehensive information on t
substance can be accessed. 

To use this feature, select one of the lookup locations from the drop-down list, and then press the Go 
button.  Your default Internet browser will open outside of WISER and show the results of the search for 
the current substance at the selected location.  

The lookup locations currently available include: 

 NLM HSDB: the Hazardous Substances Data Bank is the scientifically peer-reviewed 
database at the National Library of Medicine that serves as the primary data source for 
WISER. This option allows the complete HSDB content of a substance to be viewed, as 
opposed to the subset that is contained within WISER.  HSDB provides broad scope in 
human and animal toxicity, safety and handling, environmental fate, and more. It is one 
member of the cluster of NLM TOXNET databases (see below). 

 NLM TOXNET: this option searches for the current substance across a cluster of databases 
on toxicology, hazardous chemicals, and related areas. For more details, see 
http://toxnet.nlm.nih.gov/index.html. 

 NLM TOXMAP: this option searches for the current substance in the Division of Specialized 
Information Services of the National Library of Medicines Geographic Information System.   
This system helps users visually explore data from the U.S. Environmental Protection Agency 
(EPA)’s Toxics Release Inventory and Superfund Program.  For more details, see 
http://toxmap.nlm.nih.gov/toxmap/main/index.jsp.  

 NLM PubMed: this option searches for the current substance at PubMed, a service of the 
National Library of Medicine that includes over 15 million citations from MEDLINE and other 
life science journals for biomedical articles back to the 1950s. PubMed includes links to full 
text articles and other related resources. For more details, see 
http://www.ncbi.nlm.nih.gov/entrez/query.fcgi?. 

A preference is available to turn off the on-line lookup feature.  
This might be desirable, for example, if the standard operating 
mode is in a disconnected environment. The preference, shown 
at the right, is accessed by selecting Preferences… from the File 
menu. 

2.3.2. Viewing Multiple Substances at Once 

Because the WISER application is an MDI application, it is possible to view data on multiple substances 
concurrently. For example, suppose you would like to view the data on Isopropanol and n-Butyl Alcohol 
side by side.  This can be accomplished by opening the Data Window for Isopropanol and then n-Butyl 
Alcohol and tiling the windows in a horizontal or vertical manner.  The following outlines the steps 
necessary to display the data for Isopropanol and n-Butyl Alcohol at the same time. 

http://toxnet.nlm.nih.gov/index.html
http://toxmap.nlm.nih.gov/toxmap/main/index.jsp
http://www.ncbi.nlm.nih.gov/entrez/query.fcgi?
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Using the WISER application, begin to type in the text field the name of the substance you are interested 
in.  Once the substance is available in the list, double-click on it to display its Data Window and return 
back to the Main Window. 

 

   
Perform the same steps above, but this time for the n-Butyl Alcohol substance.  Once this is done, you 
will need to tile the Data Windows so you can view both substances at the same time.  Clicking on the 
“Window” menu item will give you a list of all of the Windows that have been opened including the home 
or Main Window as seen here: 

 
From here we can see that there are three open windows: the Home (Main window) and the two Data 
windows that were just opened.  To arrange the Windows side-by-side click on the “Arrange” menu item 
and select either “Tile Vertically” or “Tile Horizontally” to arrange the three windows.  As seen in the 
following figure, all three windows have been arranged vertically.  

Options to arrange the 
list of open windows. List of open windows 

1. Enter the name of the 
substance on the main window 

2. Double-click to launch 
the Data Window. 

3.  Click on the Home 
button to return to the Main 
Window 
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For more space you can close the Home 
window by clicking the X and re-arranging the 
Data windows via the “Window” menu item. 

 
The following figure shows the same two Data Windows after the Main Window has been closed and the 
remaining two Data Windows have been re-tiled vertically. 
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2.4. Help Identify 
Note:  This feature only supports identification of chemicals. The substances in WISER’s radioisotope 
and biological substance lists are excluded. 

Note:  The sections that follow contain references to substance counts which may change as updated 
versions of the WISER database are released.  This would be caused by the addition of new substances 
or updates to the search data. The counts reflected in these sections should be used for example 
purposes only. 

When the chemical involved in an incident is unknown, WISER can assist in identifying it. This capability 
is accessed via the Help Identify button on the Main Window.  It allows the user to select symptoms, 
properties, NFPA 704 hazard values, and substance categories to narrow down the list of possible 
substances. To return to the Main Window, select the Home button on the toolbar, or close Help Identify 
by clicking its close button (the ‘X’ in its top-right corner). 

There are two main areas of the Help Identify. Most of the window consists of a set of tabs: 

 a Start tab from which searches are initiated, a Properties tab for indicating physical 
properties of the unknown substance 

 a Symptoms tab for entering symptoms of victims exposed to the unknown substance 

 a Categories tab for entering the substance category(ies) that can be used to classify the 
substance 

 a NFPA 704 tab for entering placard values 

 an All Selected tab for viewing all of the properties, symptoms, substance categories, and 
NFPA 704 values together that have been selected so far for the search 

 a Results tab that displays the results of the search 

The bottom portion of the window consists of a progress bar that indicates the number of substances in 
the WISER data and how many of those substances are currently in the result set. 
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Tab selectors 

 

Searches are started from the Start tab. Select the Properties, Symptoms, Categories, and NFPA 704 
tabs to enter physical properties of the unknown substance, symptoms of victims of exposure, substance 
categories by which the substance can be classified, or NFPA 704 placard values. As “search values” are 
entered on those tabs, the results set will shrink, as indicated by the progress bar at the bottom of the 
window. Finally, select the Results tab to display a list of the substances in the results set. Substances 
can be selected from there to display the Data Window. 

2.4.1. Start Tab 

The Start tab is used to initiate 'searches' within the WISER substances for an unknown substance. The 
New Search button clears the selections of the current search. The progress bar resets to the maximum 
number of substances, and the search starts over. 

Each time a new search is started, the selections of the previous search are saved so that they can be 
recalled later via the Previous… button. See Previous Searches Dialog below. 

2.4.2. Properties Tab 

To enter physical properties of the unknown substance, select the Properties tab. 
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The main content of the Properties tab is a column of buttons representing the categories from which 
properties can be selected, and a list showing the current selections. The property categories consist of: 

 State 

 Color 

 Clarity 

 Odor 

 Taste 

 pH 

 Specific Gravity (or Density) 

 Vapor Density 

Selecting one of the category buttons, such as 'State', displays a list of the properties in that category. 
Next to each property option is an indication of the number of substances having data that match that 
property AND each of the other property, symptom, category, and NFPA 704 selections already made. 
Note that these numbers include substances that do not have sufficient data to determine whether or not 
there is a match. For example, in the odor category, the number displayed next to each odor option 
represents the number of substances that indicate that odor, plus the number of substances which don’t 
have odor data, and thus it can’t be determined if they have the odor. This follows the general philosophy 
that searches should err on the side of inclusiveness rather than exclusiveness, thus reducing the risk of 
the unknown substance being unintentionally excluded from the search results. 
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Following selection of a property, the Selected Properties list on the Properties page updates to reflect 
the selection. The steps in selecting a property are shown in the following figure. 

Click here Click here 

 

A property displayed in the Selected Properties list can be clicked to return to the category that it was 
selected from, just as if the corresponding category button was selected. The options in that category that 
are already selected have a check in their checkbox. Additional properties can be selected and selecting 
a checked property will uncheck it, removing it from the search. The following image illustrates the 
Selected Properties list following the selection of several properties, and demonstrates removal of one of 
those properties.  Once the property is removed, you will see that the results count has increased, which 
reflects the addition of those substances that were previously removed.  Also, the Selected Properties list 
no longer contains the removed property. 
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Click one of these 

Reset the algorithm an
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The next image illustrates two property lists that provide examples of related options, where one or more 
options are available that are more specific descriptions of a single more general option. 

 
 

In the case of the State category, there is a ‘solid’ option, and then three additional solid options that are 
more specific, such as ‘solid, crystalline’. The substances that will be matched by choosing the more 
general ‘solid’ option are inclusive of all the substances matched by one of the more specific options. If a 
more specific option is chosen, such as ‘solid, crystalline’, then selection of the more general ‘solid’ option 
is not necessary. 

A similar situation exists for the pH category, where the broad ranges of acid and base can be selected, 
or a more specific range within those can be selected, such as “weak acid”, “moderate acid”, and “strong 
acid”. In this case, indenting is used to help illustrate the relationships, and the names of the options are 
augmented with the numeric pH values that the named range applies to. 
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For the properties Odor and Taste, ‘other odor’ and ‘other taste’ options are available at the bottom of 
their respective property lists, as shown in the following figure. 

 

The ‘other odor/taste’ options capture the substances that have an odor/taste, but not one that can be 
associated with one of the specific odors/tastes in the list. If you have odor or taste observations 
available, you should first examine the rest of the properties in the list, which begin with 
odorless/tasteless, and continue with specific odors/tastes. If a suitable match cannot be found, then 
resort to selecting the ‘other’ option at the bottom. ALL substances that include odor or taste data are 
included in the ‘other’ option; if a specific odor or taste is selected, then it would not be appropriate to also 
select the ‘other’ option. 

2.4.3. Symptoms Tab 

To enter patient symptoms of the unknown substance, select the Symptoms tab. 
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The main content of the Symptoms page is an image of a human body with selectable regions that 
identify the categories from which symptoms can be selected. A dropdown list above the image can also 
be used to select the categories. To the right of the image is a list showing the selectable symptoms for a 
given category and above this is a dropdown list which can also be used to select. On the far right is the 
list of symptoms that have been selected so far. The regions of the human body image that can be 
selected are shown below, with the names of the symptom categories to which they correspond (if 
different): 

 brain (neurological category) 

 eyes 

 ears 

 nose 

 mouth and throat 

 lung (respiratory category) 

 heart (cardiovascular category) 

 stomach/kidney (gastro/urinary category) 

 arm (skin category) 

 thermometer (body temperature category) 

Selecting one of the above areas of the body, such as the brain, displays a list of the symptoms options in 
the corresponding symptom category, such as ‘neurological’.  Next to each symptom option is an 
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Note that following characteristics of the symptom options: 

 The number of substances displayed next to the symptom options includes substances that 
do not have sufficient data to determine whether or not there is a match. In other words, the 
number represents the number of substances that cause that symptom, plus the number of 
substances which don’t have symptom data, and thus it can’t be determined if they cause the 
symptom. This follows the general philosophy that searches should err on the side of 
inclusiveness rather than exclusiveness, thus reducing the risk of the unknown substance 
being unintentionally excluded from the search results. 

 Symptoms are placed in the categories where they are observed. For example, 
“cyanosis/blue” is a symptom in the skin category. Cyanosis is not a skin symptom, but signs 
of cyanosis are evident in the skin. 

 Symptoms may occur in more than one category. Sneezing, for example, can be found both 
in the Nose and the Respiratory categories. Other examples are Hypoxia/Cyanosis 
(Respiratory and Cardiovascular categories), Numbness/Tingling (Skin and Neurological 
categories), and Coughing/Choking (Respiratory and Mouth/Throat categories). For such 
options, the number of substances displayed next to the symptom in one category may not 
match the number displayed next to it in another category. This is because of the inclusion in 
those numbers of substances that don’t have data. For example, the number of substances 
known to cause sneezing will be the same regardless of whether sneezing is chosen from the 
nose or respiratory category, BUT the number of substances that do not have symptom data 
for the nose category may be different than the number that do not have data for the 
respiratory category. Thus, the inclusion of these “unknowns” may produce slightly different 
results depending on from which category sneezing is selected.  

Following selection of a symptom, the Selected Symptoms list on the Symptoms page is updated to 
reflect the selection. The steps in selecting a symptom are shown in the following figure. 
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Click here 
Click one of these 
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A symptom displayed in the Selected Symptoms list can be selected to return to the category that it was 
selected from, just as if the corresponding region of the body image was selected. The options in that 
category that are already selected have a check in their checkbox. Additional symptoms can be selected 
and selecting a checked symptom will uncheck it, removing it from the search as with the removal of the 
properties as seen in the previous section.  

2.4.4. Categories Tab 

The Categories tab allows for the selection of categories/classifications that can be associated with the 
unknown substance, thus reducing the results list to contain only those substances that are members of 
the selected substance category or categories. For example, if the unknown substance is in a 
methamphetamine lab, then selection of the “meth lab” substance category will reduce the substance list 
to contain only the WISER substances that are typically present in a meth lab. Or, consider an unknown 
substance that is a burning liquid. The “Class 3 – Flammable liquids” DOT Hazard classifications can be 
selected, and the results list will then contain only those substances that are members of that class. 

 
The main content of the Categories tab is a dropdown list representing the types of categories, a list of 
the category options for the selected type, and a list showing the current category selections. The types of 
categories, and the options available within each, are currently as follows: 

 Miscellaneous categories; the options consist of: 

• Meth Lab 

• Chemical weapons precursors 

 DOT Hazard Classifications; the options consist of each of the classes and divisions defined 
by this classification scheme 
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Selecting one of the category types, such as DOT Hazard Classifications, displays a list of the substance 
categories that can be selected 
for that type. Next to each 
category option is an indication 
of the number of substances 
having data that match that 
category AND each of the other 
property, symptom, category, 
and NFPA 704 selections 
already made. 

 

nd 
ory 

it from 

hoose 
 

y 

Following selection of a 
category, the Selected 
Substance Categories updates 
to reflect the selection. The 
steps in selecting a substance 
category are shown in the 
following figure. 

A category displayed in the 
Selected Substance Categories 
list can be clicked to return to 
the category list that it was 
selected from, just as if the 
corresponding category type 
was selected from the drop-
down list of type. The options in 
that category list that are 
already selected have a check 
in their checkbox. Additional 
categories can be selected, a
selecting a checked categ
will uncheck it, removing 
the search. 

Note that, in the case of the 
DOT Hazard Classification 
categories, there is a 
hierarchical relationship 
between some of the options, 
namely, classes that can be 
further broken down into 
divisions. For example, in 
addition to being able to c
the “Class 1” category, there are also individual divisions within that class that can be chosen.  If choosing
the more general “Class 1”, the matched substances are inclusive of all of those that are also matched b
each of the division 1.x categories.  Note, however, that choosing each of the division options separately 
is NOT the same as choosing the Class option by itself; if each of the divisions where chosen, a 
substance would have to be a member of each one of those divisions to result in a match. 

Click 
here 

selections 
are 
shown 
here

Select  
desired 
category 

 Select 
from 
here 
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2.4.5. NFPA 704 Tab  

To enter hazard values from an NFPA 704 placard, select the NFPA 704 tab. This presents the hazard 
placard diamond that identifies the health, flammability, instability, and special hazards of a material and 
the degree of severity for each. 

From a given placard, enter the observed values into the corresponding hazard diamonds, using the 
drop-down list in each of the diamonds that provides the list of severity values. As each value is entered, 
the results count decreases. This reflects the narrowing down of the results list to include only those 
substances whose NFPA 704 data matches the values that have been input, AND which match any other 
property, symptom, and category data that has been entered on the other tabs. 

 
The NFPA 704 searching tool supports both full and partial placard inputs.  Simply leave the selection 
blank for any hazard diamond for which data is not available (for example, part of the placard is destroyed 
or otherwise not legible).  The results will reflect those substances that have documented NFPA 704 
ratings matching the provided hazard inputs, ignoring the hazard data that has been left blank and 
excluding substances for which NFPA 704 ratings are unknown.  In addition, note that this feature is only 
intended for placards that represent a single substance.  If a single placard is being used for an area 
where many chemicals are present, the placard will summarize the maximum ratings in each category, 
the combination of which may not match any of the individual substances or any of the substances in 
WISER.  
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2.4.6. All Selected Tab 

The All Selected tab displays all of the selected symptoms, properties, categories, and NFPA 704 hazard 
values that have been chosen while trying to identify a substance.  At any time during a search this tab 
can be selected to view this cumulative list of selections.  Double-clicking on an item in the list will switch 
to the tab that corresponds to that item, with the corresponding category selected, at which point the 
selected item could be removed or additional selections made. 

Double-click here 

 

2.4.7. Results Tab 

The Results tab displays a list of the substances that match ALL of the properties, symptoms, categories, 
and NFPA 704 hazard values that have been selected during a search for an unknown substance. 
Double-clicking a substance in this list displays the Data Window, the same as selecting a substance 
from the Main Window.  Pressing the Details button will also display the Data Window. Both methods are 
shown below. To return to the search results, press the back button on the toolbar, or close the Data 
Window with its close button (the ‘X’ in its top-right corner); the toolbar’s Home button returns to the Main 
Window. 
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Double click here 
or press here 

Click to return to search window 

 

If a substance in the list is known to not be the unidentified substance, remove it from the results by 
clicking once to select it in the list, and then press the Remove button as shown in the following figure.  
Or, right-click on the substance and select ‘Remove’ from the resulting pop-up menu. 
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Click here to highlight substance 

Click here to remove substance 
 

The size of the results list indicated next to the progress bar decrements to indicate the removal. 

Any substances removed in this manner can be displayed again if the Show Removed checkbox is 
checked, as shown in the next figure. 
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Selecting the “Show 
Removed 
Substances” 
checkbox results in a 
“Removed” node in 
the list with all of the 
substances that have 
been removed under 
it. 

 
 

As shown above, when removed substances are shown, they appear as children of a collapsible 
“Removed” list item. Such items can be reinserted into the list by again clicking the substance, and 
pressing the Reinsert button.  Clicking on the “Removed” list item will change the text on the Reinsert 
button to Reinsert All, which can be used to reinsert all of the substances under the “Removed” list item.  
When substances are reinserted back into the result list, they are removed from the “Removed” list item 
and placed back into the main result list.  Reinsertion can also be performed by right-clicking on a 
removed substance or the “Removed” list item and then selecting the reinsert option from the resulting 
pop-up menu. When there are no substances left to reinsert the “Removed” list item is removed from the 
result list. 

Press to reinsert 
all of the 
substances. 

 

The Sort By pull-down menu controls the ordering of the results list. By default, the list is sorted 
alphabetically by name. It can also be sorted by the following identification numbers: UN/NA, CAS 
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e, the results list is ordered by UN/NA number, but three of the substances 

 

 

orresponding group, and thus it is not known whether any of 
the options in the selected grouping apply. 

registry, and STCC. When sorted by a number, the substance names are prefixed with the chosen 
number type. If a substance does not have the selected number assigned, ‘X’ characters are used as 
placeholders. In the next figur
do not have such a number. 

Click here and 
select UN/NA 

 

The Group By pull-down menu groups the substances in the list by one of the property, symptom, 
substance category, or NFPA 704 hazard groupings. When a grouping from this menu is selected, the 
results list changes to a list grouped by the properties, symptoms, category, or NFPA 704 hazards in the
selected grouping. Each is followed by a number indicating how many substances are in the grouping. 
Grouping for properties, symptoms, categories, or NFPA 704 hazards that do not contain any substances
are not shown. The list of groupings may be augmented with an “Unknown” grouping. This contains the 
substances which do not have data for the c
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Click here and 
choose one 

 

To view the substances within each grouping, expand the grouping by clicking the “plus sign” to the left of 
the groupings. Click again to collapse. 

When the results list is grouped, substances can still be removed (though the groups themselves cannot 
be removed). Note that when a substance is removed from a grouped display, that substance is removed 
from the results list, not just from that grouping. In other words, that substance will be removed from all 
groupings in which it occurs. To make this clear, removal of a substance from a grouped results list 
results in a confirmation dialog, as illustrated in the following figure. 
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In this example note that following the removal of Mercuric Chloride, not only has it been removed from 
the “solid, crystalline” grouping, but it has been removed from the “solid, powder” grouping as well. Since 
all substances had been removed from a grouping, the group was removed.  Groupings will never have a 
count of [0]. 

To remove substances from a grouped list without the confirmation dialog shown in the above example, 
check the “Don’t show this again” option before selecting the OK button. This option can also be toggled 
in the Preferences dialog (see the Search Preferences section below). 

2.4.8. Search Preferences 

User preferences that affect Help Identify are available on the Preferences Dialog, accessed from the File 
menu seen in the following figure: 

Click once here  
Press Remove 
button

Press to confirm removal 
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Click here  

 

The one option currently available on the Preferences dialog controls whether or not a confirmation dialog 
is presented when a substance is removed from the Results list while that list is grouped. This is detailed 
in the Results Tab section above.  

2.4.9. Previous Searches Dialog 

A fixed number of previous searches are automatically saved and can be resumed.  Select the 
Previous… button on the Start tab to display a list of the saved previous searches. Up to 10 previous 
searches are available, with each providing an indication of the number of substances matched by the 
search. Double-click one of the previous searches in the list or select one of the items in the list and then 
press the OK button. The dialog closes, returning to Help Identify, where the property, symptom, 
category, and NFPA 704 selections from the chosen previous search have been restored. This process is 
illustrated as follows. 
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2.5. Tools 
“Tools” refers to a set of utilities and reference materials available within WISER which are not specific to 
WISER substance data. 

A “Tools” menu on the application window’s main menu bar can be used for accessing the tools, though a 
more visual method of accessing them is via the “Radiological Tools”, “Biological Tools”, and “Chemical 
Tools” tabs on the right edge of the application window. To display the available options, move the mouse 
over (“mouse-over”) the desired tab. A “toolbox” dialog will automatically pop up, floating over the other 
windows, and then automatically close when the mouse is moved off it. If a tab is clicked (instead of 
mousing over it), then the toolbox will remain open until the mouse is clicked outside of it. 

Click here  Double click here  

Click the cancel button to 
exit without selecting a 
previous search  

The previous search has been loaded and the 
result count reflects the previous search count. 
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…move the 
mouse over one 
these tabs, or 
click on a tab …  

… and the 
corresponding 

“toolbox” 
appears 

Use this menu 
option to access 
tools, or…  

Click on one of 
the options 
within the 
toolbox to 
launch the tool  
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The toolbox can also be made to remain open and share the application window with the other content 
(rather than floating over top of it) by “pinning” the toolbox. This is done by clicking the thumbtack, as 
shown below. 

Click the 
thumbtack to 
“pin” the 
toolbox…  

… and the 
application 

window splits 
between the 
main content 

and the toolbox 

Click the 
thumbtack again 

to “unpin” the 
toolbox 
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Selecting any of the tools within a toolbox will open a new window for the tool. 

A separate toolbox is available for each of the three substance types (chemical, biological, radiological) to 
capture tools relevant to dealing with incidents of the respective types. Tools which are common to all 
substance types will appear in each toolbox. For example, the ERG tool is available in each of the 
toolboxes, while the Radiological Tools includes several tools specific to radiation events. 

Within each toolbox, and within the Tools menu of the main menu bar, tools are grouped as follows: 

 Guidebooks (common to all substance types) 

• Emergency Response Guidebook:  a comprehensive, fully-searchable electronic 
version of the DOT ERG 

• WMD Response Guidebook:  view the guide pages of this publication 

 Triage (common to all substance types) 

• START Adult Triage Algorithm: the user is led step-by-step through the algorithm 
until a tag assignment can be determined 

• JumpSTART Pediatric Triage Algorithm: the pediatric version of the START algorithm 

 Radiological Tools 

• Calculators 

 Dose Estimator – Onset of Vomiting: estimation of whole-body radiation dose 
based upon the onset of vomiting 

 Radiation Unit Converter: provides conversion between various standard and 
international units 

• Reference Materials – browsing of the following documentation is provided: 

 Emergency Contacts 

 Initial Onsite Activities 

 Manual for First Responders to a Radiological Emergency (action guide 
excerpts for on-scene roles) 

 Radiological Terrorism – Emergency Management Pocket Guide for 
Clinicians 

These tools can be considered as consisting of three general types, which are detailed further in the 
subsections which follow: 

 General utilities with their own unique content and functionality. 

 Algorithms – these are presented in an “algorithm viewer” which allows the user to respond to 
questions and walk through a path of an algorithm or flow chart in a “wizard-like” fashion. 

 Reference Materials – these are instances of reference documentation, and are presented in 
a reference material viewer that provides for the browsing of all reference materials. 

2.5.1. General Tools / Utilities 

Individual tools are presented in a new window containing only the functionality of that that tool, and 
which can be interacted with separately from the WISER window. Examples of such tools include 
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 Dose Estimator - Onset of Vomiting (see the Radiological Tools) 

 Radiation Unit Converter (see the Radiological Tools) 

 Emergency Response Guidebook 

 For example, the following is the Emergency Response Guidebook (ERG) tool: 

Clicking here… 
 
…opens the 
ERG tool 

Click here 
to close

 
Click the top right corner ( ) of a tool window to close it. 

 



 

WISER User's Guide Using WISER 

 
 
 

2008-04-24 National Library of Medicine Page 53 

 

2.5.2. Algorithms 

An algorithm viewer is available for helping the user 
walk through processes that involve multiple steps and 
decision points, often presented as a “flow chart”. In the 
toolbox, these tools are displayed with a flow chart 
symbol next to them: . Examples include the START 
and JumpSTART triage algorithms. Clicking any of 
these opens an algorithm viewer window with the 
following components: 

Click an algorithm option 

 “Navigate” tab: used to step through the 
algorithm 

• Left pane: content;  displays the 
steps/questions of the algorithm one at a 
time 

• Right pane: history;  shows each of the 
steps that have been completed and the 
responses that have been selected; can be 
used to navigate back to previous steps to 
review and/or change responses 

 “Preview” tab: displays a diagram of the entire algorithm 

The initial display for an algorithm consists of an introduction, a button to begin navigation of the 
algorithm, and a button that previews the entire algorithm (same as clicking on the preview tab). Press the 
navigate button, and respond to the questions presented until an endpoint is reached (the content pane 
will not contain any responses to select). Click the top right corner (

oduction, a button to begin navigation of the 
algorithm, and a button that previews the entire algorithm (same as clicking on the preview tab). Press the 
navigate button, and respond to the questions presented until an endpoint is reached (the content pane 
will not contain any responses to select). Click the top right corner ( ) of the algorithm viewer to close it. 

Click here to close Click here to begin  Content pane (algorithm steps)  History pane  

 
The left and right arrow keys at the bottom of the history pane provide for backing up and going forward 
through the steps already visited. To quickly return to a specific step, click that step in the list displayed in 
the history pane. Upon returning to a previous step, a different response can be chosen, and navigation 
resumes at that point of the algorithm. Boldface is used in the history pane to highlight the step that is 
currently being viewed in the left content pane. 
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Click here to return to this step 

Current step is highlighted in the history 

These buttons sequence 
through the history
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Algorithm end point (no responses to choose from) 

Preview tab displays the complete algorithm 

Reset the algorithm and start over 
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2.5.3. Reference Materials rials 

Reference material options in 
the toolbox are displayed with 
a document symbol next to 
them:

Reference material options in 
the toolbox are displayed with 
a document symbol next to 
them: . 

 

Selecting any of these opens 
a reference material viewer 
with two panes: 

 The right pane 
displays the selected 
content. 

 The left pane c
a “tree” represent
the table of contents 
of all reference 
materials for a 
particular group
for example, a
radiological re
materials. This tree 
can be used to 
navigate to and 
display the other
documents include
in the reference 
materials. 

In the table of conte

ontains 
ing 

ing, 
ll 
ference 

 
d 

nts, the 
f 

at they 
nts 

 

f the reference material viewer allows for navigation back and forth through the 

books represent groupings o
related documents, and can 
be opened to view the 
individual documents th
contain. Individual docume
can be selected to view their content in the right pane. In addition, when clicking a book, the right pane
displays all of the documents within that book, concatenated together into a single document. 

A toolbar along the top o

Click on a 
reference 
material 
option 

history of previously viewed documents, as well as a print button that will print the contents of the right 
pane.
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Content pane – displays 
selected document Table of Contents pane 

Toolbar options for 
printing and for 
navigating the history 
of viewed documents 

Click books to open Click documents to 
view their contents

Click here to 
close the viewer

 

2.6. Event Tracking 
All user actions performed in WISER are tracked (logged) in time stamped entries in a text file. This 
information may be useful in recreating and reviewing WISER activity following an incident in which it was 
used. 

This is done in a user-specific file called “wiser_tracking.txt”, located in the folder: 
        C:\Documents and Settings\<user name>\Application Data\National Library of Medicine\WISER\<wiser version> 

Its size is automatically limited to avoid unnecessary waste of storage space. 
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3. Tutorial 
In this section, two scenarios are given as a tutorial for using WISER.  In the first scenario, the substance 
is known; in the second, the substance is not known.  WISER can be used in both of these scenarios to 
assist in responding to the incident. 
Note:  The tutorial section contains references to substance counts which may change as updated versions of the 
WISER database are released.  This would be caused by the addition of new substances or updates to the search 
data. The counts reflected in these sections should be used for example purposes only. 

3.1. Known Substance 
In this scenario, you are the first responder at a scene.  There is an overturned cargo tank with ‘Hydrogen 
Peroxide’ on the side; the papers on board and the driver verify that it is hydrogen peroxide.  There is a 
small fire caused by the engine on the cargo tank.  The driver of the truck has been splashed with the 
hydrogen peroxide and may have ingested some of it. 

 

The immediate tasks are to clear out an appropriate area around the tanker truck, treat the driver, and 
correctly respond to the small fire.  Using the WISER application, you enter an ‘h’ in the text field.  The list 
of substances will scroll down to substances beginning with ‘h’. Continue entering letters until hydrogen 
peroxide is visible in the list (or use the scroll bar to advance the rest of the way). 

Double-click on hydrogen peroxide (above figure).  This will bring up the Data Window for hydrogen 
peroxide, showing the Key Info. 

To determine the appropriate area to clear out, select the Protective Distance option in the data menu, as 
shown in the following figure. This brings up the Evacuation distance information from the DOT 
Emergency Response Guidebook (ERG). (The ERG is also accessible in its entirety by selecting the 
Hazmat submenu.) 
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Click either item to bring 
up the data menu  

Click here 
 

For information on the correct response to the fire, select the Fire Procedures hot link in the data menu, 
as shown below. (The Fire Procedures is also accessible from the Hazmat submenu). 

Click here  

Click here to bring up 
the data menu 

 

Finally, treatment of the driver can be determined by selecting the Treatment hot link, as shown below. 
(The treatment data is also accessible from the Medical submenu).   
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If more in-depth information is required, such as physical properties, it can be found by selecting the 
category of interest in the data menu, and then the desired data element from the resulting submenu. For 
example, to view information about decomposition, you select the category ‘Properties’ from the data 
menu, and then ‘Decomposition’ from the resulting submenu. 

3.2. Unknown Chemical Substance 
In this scenario, you are the Hazardous Materials Specialist responding to an incident at a warehouse.  
The warehouse has been cleared and the situation has been stabilized.  Your primary task is to identify 
the substance and provide information and recommendations to the Incident Commander.   

The substance in question has been leaking from an unmarked barrel.  It has been described as a 
colorless liquid with an alcohol smell.  The workers from the warehouse are showing the following 
symptoms:  nausea, dizziness, headache, eye irritation, and low body temperature. 

Using WISER in this situation, you select the Help Identify button on the Main window.  If there is an 
existing search in progress, you should select New Search to save the search and clear out the 
symptoms, properties, and NFPA 704 selections.   

To enter the properties of the substance, select the Properties tab. Start property selection by selecting 
‘State’ to bring up the possible values of physical state, and selecting ‘liquid’.  Liquid is now shown in the 
selected list and the number of matching substances has been reduced to 279 of the original 414. 

Click here to bring up 
the data menu 

Click here 
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Matching substances reduces to 279 

Click here to display the list of states and 
then click liquid in the list. 

 

Then, following the same process, select colorless from the Color property and select alcohol-like from 
the Odor property. 

The result of using the properties liquid, colorless, and alcohol-like odor is that the original list of 414 
substances has been reduced to 32.   

Continue with symptoms selection by selecting the Symptoms tab. The symptoms (nausea, dizziness, 
headache, eye irritation, and low body temperature) are selected by selecting the body part that shows 
the symptom. For nausea, click on the stomach.  

Matching substances reduces to 29 

Click here to display the list of Gastro/Urinary 
symptoms and then click nausea in the list. 

  

For dizziness and headache, click on the brain and then select the corresponding values in the list. The 
symptoms of eye irritation and low body temperature are selected similarly.  For eye irritation, click on the 
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eyes in the image of the human body.  Then, select irritation.  For low body temperature, click on the 
image of the thermometer and then select low body temperature.  To view the results of the search, 
select the Results tab shown below. 

Click the results tab to view the 
substances 

 

The search to this point has resulted in 8 substances that match the symptoms and properties selected.  
To determine the correct substance, the Results page allows the user to group and sort the substance in 
different ways, remove substances that are known to be incorrect, and go to the Data Window for the 
substances. 

In this tutorial, the user groups by various symptoms and properties until getting to Specific Gravity and 
that information is used to narrow down the substances even more.  Here, the user clicks on the Group-
by drop-down list, and selects Specific Gravity.  Based on the results of the grouping, the user tests the 
substance and observes that the substance is not soluble and floats on water.  Thus, the “sinks in water” 
substances can be removed.  As demonstrated below, this is done by expanding the “sinks in water” 
grouping, and then selecting each substance and clicking the Remove button. 

Click here 

Click here 

Expand 

Remove each of these substances 
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The remaining substances need to be examined in more detail to determine the correct substance.  First, 
examine those under the “Unknown” grouping, indicating that WISER does not have specific gravity data 
for them.  Selecting Sulfur Trioxide to view the Data Window, the Key Info indicates that it is water-
reactive.  Further investigation indicates that the melting point is 16.8° C. So, at the current temperature, it 
should be a solid.  It is thus likely that this substance can be removed. 

Double-click 
here 

Click here 

Click here 
Click here to 
return to results 

Click here once  
Then remove 

 

 
 

The final results of the search are 1-Hexanol, Isopropanol and n-Butyl Alcohol. Further investigation of 
each, using the Data Window, shows that these hydrocarbons have very similar characteristics and 
procedures. For example, the Emergency Response Guidelines for all three are the same. 
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4. About NLM 
The National Library of Medicine (NLM) is the world’s largest medical library.  The Specialized Information 
Services (SIS) Division of NLM is responsible for information coverage and services for several areas, 
including environmental health and toxicology, AIDS, and directories to other information resources 
concerned with health and biomedicine.  SIS maintains the Hazardous Substance Data Bank (HSDB), 
covering over 4700 substances, their toxicology, emergency handling procedures, and environmental 
fate. The NLM is part of the National Institutes of Health, an agency of the U.S. Department of Health and 
Human Services. 
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